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Overview
CBECC-COM 2016 is an open-source software program developed by the California Energy Commission
for use in complying with the 2016 update to the Non-Residential Building Energy Efficiency Standards.
This Quick Start Guide for CBECC-COM 2016 was written to accompany versions of the software released
starting in June 2016.
This Quick Start Guide provides brief descriptions of the software program’s major features. It is a good
idea to review the Quick Start Guide before using the program for the first time or if you have questions
while using the program. Additional Help features will be added to future versions of the program.
New in Version 2016.3.0 VRF Beta
The capability of explicitly modeling Variable Refrigerant Flow (VRF) systems has been added. These
systems are modeled by adding a new object called 'VariableRefrigerantFlowSystem' (VRFSys) at the
Building level, which represents the outdoor unit. The indoor fan coils are then defined as ZoneSystems
of Type = 'VRF', each assigned to their respective thermal zones. Each fan coil references its respective
VRFSys object. The indoor unit ZoneSystem must have a child heating coil and cooling coil of Type =
'VRF', as well as a fan object. It is recommended that the simulation inputs (capacities, efficiencies etc.)
for the VRF systems being designed for the project be specified based on the AHRI rating conditions.
Bugs Fixed in Version 2016.3.0 VRF Beta:
Fixed issue where Residential systems supplying ventilation air via DOAS and/or the Primary Air
Conditioning System to have extra ventilation air via the system and infiltration added to the zone (as if
it had exhaust based ventilation).

Note:
CBECC-Com 2016 VRF Beta is for research/testing purposes only and is not certified by the
California Energy Commission. This version cannot be used to show compliance with the 2016
Title 24 Standards.
Please note that minimum efficiency checks for the outdoor units of the VRF system have not
been implemented in this release. Those checks will be included in the final release.
The compliance report (PRF-01) for this beta release will be watermarked and will not have
updated tables to report all the VRF components.
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Example Input Files: A series of example models are installed along with CBECC-Com in the Projects
directory. These models are of various building types and HVAC systems. Note: For the betaversion of
the software all the example models listed below may or may not be included with the installation.
CEC Standard Tests
1. 010012-SchSml-CECStd
2. 020012-OffSml-CECStd
3. 020012S-OffSml-CECStd
4. 030012-OffMed-CECStd
5. 030012S-OffMed-CECStd
6. 040012-OffLrg-CECStd
7. 050012-RetlMed-CECStd
8. 060012-RstntSml-CECStd
9. 070012-HotSml-CECStd
10. 080012-Whse-CECStd
11. 090012-RetlLrg-CECStd
Other Tests
1. 010112-SchSml-PSZ16
2. 010212-SchSml-PVAVAirZnSys16
3. 010312-SchSml-VAVFluidZnSys16
4. 040112-OffLrg-AbsorptionChiller16
5. 040112-OffLrg-VAVPriSec16
6. 040112-OffLrg-Waterside Economizer16
7. 050112-RetlMed-SZVAV16
8. 050312-RetlMed-Alterations16
9. OffLrg-PlenumsFPBsData16
10. OffLrg-PrkgExhaust16
11. OffLrg-PrkgLab16
12. OffLrg-PrkgLabKitchen16
13. OffLrg-ThermalEnergyStorage_ChillerPriority
14. OffLrg-ThermalEnergyStorage_StoragePriority
15. OffMed-CoreAndShell
16. OffSml-ActiveBeams
17. OffSml-CombDHWSpcHt16
18. OffSml-CommKit_SZVAV16
19. OffSml-Data_SZVAV16
20. OffSml-Lab_SZVAV16
21. OffSml-MiniSplit
22. OffSml-Office_SZVAV16
23. OffSml-PassiveBeams
24. OffSml-PassiveBeams-DOASCV+HtRcvry
25. OffSml-PassiveBeams-DOASVAV
26. OffSml-PSZ-Evap16
27. OffSml-WSHP16
28. RetlMed-PVAV-IndirDirEvap16
29. RetlSml-DOAS+FPFC16
30. RetlSml-DOAS+GravityFurnace_HasNoClg=0
31. RetlSml-DOAS+GravityFurnace_HasNoClg=1
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021013-OffSml-VRFSys
021015-OffSml-VRFSys
021016-OffSml-VRFSys
021113-OffSml-VRFSysHR
021115-OffSml-VRFSysHR
021116-OffSml-VRFSysHR

Tip: Input Units
The input screens show the units for numerical inputs. For example, boiler efficiency is input as a
fraction like 0.8, not as a % like 80.

Quick Start Guide Topics
Menu of Topics in this Quick Start Guide
Updates
Starting a New Project
Analysis Types
Compliance Types
Menu Bar
Tool Bar
Main Screen
Right Mouse Button Menu Options
Building Tree Controls (Parent/Child Relationships)
Input Dialog Windows
Status Bar
Defining New Components
Deleting Project Files
How to Report a Problem
License Agreement

Updates and New Project Website
We plan to issue updates to CBECC-Com often. You can check the new project website
(http://bees.archenergy.com/) where a link to the latest version will always be posted.

Starting a New Project
When CBECC-Com is first started, a dialog box will appear with the options (No. 2 option may not be
available on new CBECC-Com installations):
1. Open Recent Project
2. Select an Existing Project to Open
3. Create a New Simplified Geometry Project
Option 1 and Option 2 are essentially the same, except that the “Open Recent Project” option
automatically selects the project that was being worked on the last time CBECC-Com was open. The
“Select an Existing Project to Open” option simply requires browsing to the desired project.
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If “Select an Existing Project to Open” is selected, the default file type in the browse window is a .cibd16
file. However, this can be changed to .cibd16x or .xml, allowing you to open a SDD XML file. This option
should be used when working on a Detailed Geometry project.

Users can take either approach (Detailed or Simplified – see User’s Manual for more information) to
modeling their project; however, the preferred workflow is to use the Detailed Geometry approach
using OpenStudio to create building model geometry using SketchUp with the OpenStudio plug-in.
OpenStudio includes an option for exporting an SDD file, which CBECC-Com can then open. The
Simplified Geometry approach is recommended for simpler buildings since this approach comes with
certain limitations that could prevent the project from getting credit for certain efficiency measures
included in the design.
For more information on the recommended workflow, please view the tutorials at
http://bees.archenergy.com/faq.html.
Return to Quick Start Main Menu

Analysis Types
Title24ProposedOnly: This will simulate the building input by the user with the 2016 compliance rules.
Title24Compliance: In addition to simulating the Proposed Design, this will simulate the Standard Design
building which complies with the 2016 Prescriptive Standards and establishes the energy budget for
compliance.
Return to Quick Start Main Menu
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Analysis Scope Options
The scope of analysis is specified through use of a series of checkboxes. Use of these checkboxes results
in specification of Compliance Type, which was input directly in CBECC-Com 2016.2.1 and earlier
versions.
New and Existing. One (and only one) of these two boxes must always be selected. In the CBECC-Com
UI, checking or unchecking either of these options results in the other option automatically being set the
opposite way.
New should be selected when the project involves construction on a site where there is not an existing
building or where the sub scope (described below) has not been previously constructed. For example, if
a new building has been built with tenant spaces that did not have lighting or mechanical systems, a
subsequent analysis addressing the lighting or mechanical systems for those tenant spaces is still New,
even though the building shell is existing. On the other hand, if that same tenant space is remodeled
later, analysis of that project would use Existing.
Existing should be selected when the project is an addition to an existing building or when an existing
building is being altered, or both.

Addition and Alteration. When Existing has been selected, the Addition and Alteration checkboxes
must be used. At least one of these must be selected, and both may be selected. An Addition means
that new conditioned floor area is being added to the building, and the construction related to that new
floor area is treated in the same way as new construction. Alteration means that portions of the existing
building are being changed in ways that affect the energy performance, but without adding new
conditioned floor area. When alterations are analyzed, determining the characteristics of the baseline
follows different rules than new construction.
When an Existing building is described in CBECC-Com, careful attention must be paid to properly
specifying the Status of all components to be New, Existing, Altered, or Future, in order to achieve a
valid analysis.

Envelope, Lighting, Mechanical, DHW. These checkboxes allow analysis of partial compliance options.
These options are used when only the specified aspects of the building are included in the building
permit and energy performance analysis.

Partial Lighting, Partial Mechanical. These checkboxes allow analysis of core and shell projects, where a
portion of the lighting or mechanical systems in the building are included in the building permit and
energy performance analysis, but other portions have either already been built or will be built in the
future.
Note that if some combinations of Existing, Addition and Alteration are selected, then Envelope,
Lighting, Mechanical, Partial Lighting, and Partial Mechanical may be automatically checked or
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unchecked and the user may not be able to change those selections. In this case, the Status of
individual components in the model will determine how the analysis will proceed.

Envelope. For all models, the building envelope, including opaque surfaces and fenestration must be
described in the user’s input model, which will provide the basis of the proposed model. When
Envelope is not checked, it is assumed that the envelope is existing and the envelope in the baseline
model will match the proposed model. If the project includes any new or altered envelope components,
then Envelope must be checked and the status of envelope components will determine how the baseline
model is specified.

Lighting and Partial Lighting. If the project includes any new or altered lighting systems, then Lighting
or Partial Lighting must checked. The status of the lighting in each space will be used to determine the
characteristics of the lighting in the baseline.
For a New project, if lighting will be designed and permitted are some point in the future, Lighting must
be left unchecked. The Status of lighting in all spaces will default to Future. In both the proposed and
baseline models, lighting will be specified by the rules and will normally be identical. If the lighting in all
spaces has been designed and is being permitted, then Lighting should be checked. If the lighting for
some spaces is designed and included in the permit, but the lighting for other portions of the building
will be designed and permitted in the future, such as for a core and shell project, then Partial Lighting
should be checked.
For an Existing project, if Lighting is unchecked, then the Status of the lighting in each space may be set
to either Existing or Future. If the Status of the lighting in a space is set to Existing, that same lighting
will be used in the baseline. If the Status is set to Future, then the rules will determine the lighting for
both the proposed and baseline (same as for New without lighting).
If the Status of the lighting in any space will New or Altered, then either Lighting or Partial Lighting (but
not both) must be checked. In this case, the baseline lighting will be different from the lighting in the
proposed model. If a project is New or an Addition where the Status of the lighting in some spaces is
Future along with other spaces with the Status of the lighting being New or Altered, then Partial Lighting
should be checked. If all spaces have the Status of lighting set to New, Altered or Existing, then Lighting
should be checked.

Mechanical and Partial Mechanical. If the project includes any new mechanical system components,
then Mechanical or Partial Mechanical must checked. The status of the systems serving each thermal
zone will be used to determine the characteristics of the baseline HVAC systems.
For a New project, if the HVAC systems will be designed and permitted are some point in the future,
Mechanical and Partial Mechanical must be left unchecked. The HVAC systems in both the proposed
and baseline models, will be specified by the rules and will normally be of the same type, with system
capacities determined by sizing runs.
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If the HVAC systems for the entire building have been designed and are being permitted, then
Mechanical should be checked. If the systems serving some thermal zones are designed and included in
the permit, but for other portions of the building will be designed and permitted in the future, such as
for a core and shell project, then Partial Mechanical should be checked.
For an Existing project, if Mechanical is unchecked, then the Status of the systems may be set to Existing
or at the Thermal Zone, “HVAC is unknown” should be checked. This checkbox is used for either existing
systems where the details are unknown or for systems that will be designed in the future. In either case,
the rules will determine the system configuration for both the proposed and baseline models with sizing
determined by sizing runs.

DHW. DHW may be checked or unchecked regardless of other analysis scope options. If it is included,
then DHW systems must be specified and all spaces assigned to a residential DHW system or a fluid
system of type service hot water. If DHW is not checked, the rules will create systems for both the
proposed and baseline models.

Return to Quick Start Main Menu

Menu Bar
This section explains the program features you access by selecting the options on the menu bar at the
top of the screen.
File – The File menu contains the standard functions for file management, loading recently used files,
saving a newly created file, print a file and exiting the program.
Edit – In addition to the standard Windows™ Cut, Copy, and Paste commands, the Edit menu contains
several commands for editing building descriptions. They are:
•
•
•

Edit Component
Create Component
Delete Component

These menus allow you to edit all building components, including components that are not displayed on
the tree control. Use this method to edit components like schedules and performance curves.
Ruleset –CBECC-Com 2016 is designed to support multiple rulesets that implement the requirements in
different codes. However, different codes can require different information, and therefore, compliance
projects and model inputs defined using one ruleset will likely need to be revised to work with other
rulesets. This function may or may not be enabled in this version of the software.
View – Enables you to toggle the display of the Tool Bar and the Status Bar on and off.
Tools – The Tools menu contains the following options of interest to end-users:
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Program and Analysis Options – Allows users to set the various options related to storage of
simulation output and analysis files. Also allows users to set the proxy server settings to enable
access to the online report generator if the computer is behind a firewall
View T-24 Compliance Report – Allows users to open an approved CBECC-Com2016 compliance
report in the local PDF document viewing software; typically Acrobat Reader. If no valid report
or results file is found it will prompt the user to perform the compliance analysis before
generating and/or viewing the compliance report.
View Project Folder - Allows easy access to users to open the folder where all the project files
are stored and/or generated on analysis.
View Project Log File - Allows users to open the project log file in the local text editor software;
typically Notepad.
Delete Project Log File - Allows users to delete the project log file generated for the project.
Typically the project log file gets appended with information on opening/saving and running the
project. So if the user wishes to start with a fresh project log file this option allows the user to
delete the old log file.
Perform Analysis – Performs compliance input checks and simulations based on the current
building description.
Review Analysis Results – Allows users to review the results of the last simulation analysis that
was performed for the project. Please note that if any changes to the project were made after
the analysis and the project was not simulated again, the displayed results would not be current.
Generate Draft T-24 Compliance Report – Generates a watermarked compliance report (pdf) for
review/printing. This watermarked report cannot be used to submit for compliance.

Help – The Help menu contains the following options of interest to end-users:
•
•

Quick Start Guide – Opens up the Quick Start Guide for the software in the local PDF document
viewing software.
User Manual - Opens up the User’s Manual for the software in the local PDF document viewing
software.
Return to Quick Start Main Menu

Tool Bar
This section explains the program features you access by selecting the icons on the tool bar at the top of
the screen.
New File
This button closes the current file (if one is open) and opens a new file.
Open Existing File
This button closes the current file (if one is open) and launches the Open dialog to enable you to
select an existing file to open.
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Save File
This button saves the file under its current name or, if you have not named the file, launches the
Save As dialog to enable you to provide a new file name.
Cut Selected Item
This button is not currently enabled in CBECC-Com 2016.
Copy Selected Item
This button enables you to copy the selected item on the tree control (along with any child
components) to the Windows clipboard. The Copy button is not available from within program dialogs,
but you can use the keyboard equivalent, Ctrl+C, to copy selected text.
Paste Contents of Clipboard
This button enables you to paste components copied from the tree control to the selected location
in the tree control (provided that location is compatible with the stored component). The Paste button
is not available from within program dialogs, but you can use the keyboard equivalent, Ctrl+V, to paste
text from the Windows clipboard to the selected input field.
Print
This function is not available in CBECC-Com 2016.
Building Creation Wizard
This function is not available in CBECC-Com 2016.
Perform Analysis
This button enables you to launch a compliance analysis using the currently loaded building
description. The behavior of this button identical to the Tools menu option. You must save the current
building description before performing the analysis.
Compliance Reports
This icon opens an approved CBECC-Com2016 Report in your local document viewing software;
typically Acrobat Reader. The behavior of this button identical to the Tools menu option - “View
Compliance Report”. You cannot open an approved report unless an analysis has been performed and
the model has not been modified since the analysis has been performed. This button may or may not be
enabled in this version of the software.
About CBECC-Res 2016
This button enables you to view program license and version information.
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Print Preview
This function is not available in CBECC-Com 2016 and will be removed in future versions.
Help
Not yet implemented. For help with the program, please refer to this Quick Start Guide.
Return to Quick Start Main Menu

Main Screen
The main screen of the CBECC-Com 2016 program is used primarily for editing building descriptions.
There are two folder tabs at the top of the main screen—Envelope and Mechanical. These tabs provide
different views of the building description and provide access to two different subsets of the building
description data.
Return to Quick Start Main Menu

Right Mouse Button Menu Options
The CBECC-Com 2016 program makes extensive use of menu accessible by clicking the right mouse
button. The functions available through these menus depend on whether you are on the main screen or
in an input dialog window.
Main Screen Right Mouse Menu. When clicked over a building component, the following choices are
available:











Edit – Opens the input dialog window for the selected component
Rename – Enables you to rename the selected component
Delete – Deletes the selected component
Copy – Copies the selected component with all of its child components
Paste – Adds copied components and their children to the selected component
Move Up in list, Move Down in list – Moves the component up or down in the list of components
that share a common parent. The input file is reordered accordingly. HVAC components are
reordered and will be simulated with components in the displayed order, except for fans which
are ordered based on the Fan Position parameter. For example, an evaporative cooler placed
before or after a cooling coil will have different effects in the simulation.
View Space Footprint – Displays in your browser a diagram of the space (available for space
components only)
Expand/contract – Expands or contracts the list of children components attached to a selected
component
Create – Enables you to create new child components for the selected component

Input Dialog Right Mouse Menu. When clicked over an input value in the window, the following choices
are available:


Item Help – Not yet implemented. Accesses Help information applicable to the selected input
field.
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Topic Help – Not yet implemented. Accesses Help information applicable to the selected
component.
Restore Default – Returns the value of the field to its default value (if applicable)
Critical Default Comment –Not yet implemented. Opens a dialog enabling you to enter a
justification for overriding values designated by the Code as critical defaults, i.e., a value that
should only be overridden with special justification.
Return to Quick Start Main Menu

Building Tree Controls (Parent/Child Relationships)
In order to analyze a building's energy use, it is necessary to track relationships among building
components. CBECC-Com 2016 displays these relationships using the familiar tree control, found in
Windows™ Explorer and many other applications. For example, under the Envelope tab, exterior walls
are shown as parents to windows (windows are connected to exterior walls and appear underneath
walls) and children to spaces. The tree controls vary in the components they display and depend on
which folder tab is currently selected.
Use the Tree Control for Rapid Editing
The tree control can be used to move and copy components or groups of components. To move a
component, just drag and drop. If an association isn’t allowed, the program will prevent the move from
being carried out. To copy a component, select the component, copy, and paste. It is advisable to
rename copied components to maintain readability. Whenever parents are moved, copied, or deleted,
all related child components are also moved, copied, or deleted.
Components shown on the tree can be moved using a drag-and-drop technique to other components
provided it results in a compatible parent-child relationship. For example, you can drag a window onto a
different wall, but not vice versa. Re-ordering of child objects assigned to the same parent is currently
not supported.
A set of right mouse menu edit commands can be used with the tree control. These are described in the
Right Mouse Button Menu Options section. Double-clicking on any component on the tree opens its
input dialog window.
Return to Quick Start Main Menu

Input Dialog Windows
The attributes of each building component can be edited by opening the input dialog window for the
component. The dialog can be opened by double-clicking on the component on the tree control, using
the Edit option on the right mouse menu, or using the Edit Component option on the Edit menu. (The
tree control does not appear until you have created a project description using the wizard or loaded an
existing project file [Ctrl+O]).
In keeping with good practice for use of any software, we recommend that you save your building
description often and revise the file name once you have substantial effort invested in editing the
description under the current file name.
Background Colors
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The following background color convention has been used in displaying data on the dialogs:



White background = available for user input
Gray background = not user editable

Text Colors
The following text color convention has been used in displaying data on the dialogs:



Dark blue or cyan text = default values as defined by the current ruleset
Red text = values that have been changed from their default values

For information on editing features available from the input dialog windows, see the Right Mouse
Button Menu Options section.
To understand what information you are required to enter, see the Status Bar section.
Return to Quick Start Main Menu

Status Bar
The second and third panes of the program status bar now report detailed version IDs of (1) the
software and (2) the ruleset that is referenced by the project currently loaded into the program:

Note: The following features of the Status Bar have not been implemented in this version of CBECCCom.
The status bar at the bottom of the screen provides useful information about each input field you select.
There are three panes on the status bar that provide context-sensitive information. This same
information is displayed in the ToolTips if you allow your mouse pointer to linger over an input field.
1.
2.

3.

Input Description Pane – Concise descriptions of the selected input field are displayed at the
far left of the status bar.
Input Classification Pane – The next pane to the right on the status bar displays a set of
labels that indicates which inputs you are required to provide, which are optional, and
which are unavailable for input. The input classification labels are explained in the table
below.
Data Source Pane – The pane at the far right of the status bar displays a set of labels that
identify the source of the information (if any) contained in the field. This can help you
distinguish between information that is dictated by the compliance checking process and
the information you have entered and for which you are responsible. The data source labels
are explained below.

Input Classification Explanations
No field selected

No building data field is currently selected.
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Input is compulsory

You are required to enter data in the selected field; the program
cannot perform a compliance analysis unless you do.

Input is required

You are required to enter data in the selected field if the field is
applicable to your project.

Input is optional

You may enter data in the selected field if the field is applicable to
your project, but you are not required to do so. If the field
contains a default value, you are permitted to simply use that
value without considering its suitability for your project.

Input is critical default

You may overwrite the data in the selected field with an entry
more appropriate for your project than the default. However, if
you do overwrite this "critical default" value, you must be
prepared to provide documentation substantiating the value you
have chosen.

Field is not editable

You cannot enter data in the selected field. The data in this field
are defined by the compliance rule set or a supporting process. In
some cases, the field may also be an intermediate calculated
parameter or one that is not applicable to the currently selected
compliance rule set.

Navigation input

The purpose of the selected field is to enable you to select a
component for editing without having to exit the current
component and choose the next component from the tree

Data Source Explanations
No field selected

No building data field is currently selected.

Value from user

The data shown have been defined by the user either directly
through a user input or indirectly through wizard selections.

Value from simulation

The data shown have been defined by an energy simulation.

Value undefined

No data have yet been defined for the field.

Value from program

The data in this field have been defined by the program either to
implement requirements and procedures specified in the energy
code or to conform to building energy modeling conventions.
Return to Quick Start Main Menu

Defining New Components
There are two main ways to define new components (e.g., walls or equipment) in the main program
interface.
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Define a New Physical Component
To define a new physical component, follow these steps from the Main Program Screen:





Right-click on the component on the tree control to which you want to add the new component.
Select Create, then the type of object you want to add. (Only applicable component types will
appear on the list.)
Accept the default name, parent, and existing component to copy from or edit these fields and
click OK.
Edit the input fields with white backgrounds to describe the new component and click OK.
Return to Quick Start Main Menu

Deleting Project Files
If you have created multiple projects under different project names, you may want to delete project files
to free up hard disk space on your computer. By default, project files are stored in the C:\Users\<your
username>\My Documents\ CBECC-Com 2016 Projects\ directory, although where the files are stored
may differ on your computer depending upon where you installed the program and if you selected a
different location for storing files.
In the Projects folder, you will find several files with the same project name you used but with differing
file extensions. If you have no further use for information on a project, delete all files using the primary
file name. If you would like to retain a project but store it as efficiently as possible, delete all files using
the primary file name EXCEPT the one having a .cibd (input building design) file name extension. The
other project files are recreated when an analysis is performed, with the exception of the project .log
file. The log file lists compliance analysis warnings and errors shown in the UI, as well as other
information related to processing/simulating models. Each time analysis is performed; new messages
are appended to the end of this file, and should be reviewed when troubleshooting your compliance
analysis.
Return to Quick Start Main Menu

How to Report a Problem
This software is released for testing purposes and we anticipate the user running into errors and
problems. We appreciate your willingness to help us make progress by taking the extra time to
document and report issues in a way that will help us fix them quickly.
When you come across an issue, please log an issue at the CBECC-COM website at:
http://bees.archenergy.com/issue.html
If you experience any issues submitting an issue through the website, please send an email to:
CBECC-COM Support <cbecc.com@gmail.com>
And include as much of the following as possible (copy and paste this template into your email):
Type of Issue
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CBECC-COM version (Version can be found in the Help-> About menu) and is represented as
show below: CBECC-COM 2016

Describe the error, using as much detail as possible.
List the steps taken to produce the error, using as much detail as possible.
1. Step 1
2. Step 2 etc.
If there is an error message, what is the message? If possible, take a screenshot of the error
message and attach it to the email as a file.
Please attach your <ProjectName>.cibd16 file. This is the file you open and save from inside
CBECC-Com. By default, this file is located in the following directory, C:\Users\<your
username>\My Documents\CBECC-Com 2016 Projects.
If you include your name and phone number, we may call you to clarify the problem or ask for more
details. We will not share your name, phone number or email address with anyone outside the CBECCCom development team or use it for any purpose other than responding to your report.
Return to Quick Start Main Menu
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License Agreement
Copyright (c) 2012-2017, California Energy Commission
Copyright (c) 2012-2017, Wrightsoft Corporation
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
•
•
•

Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions,
the following disclaimer in the documentation and/or other materials provided with the
distribution.
Neither the name of the California Energy Commission nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written
permission.

DISCLAIMER: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT ARE DISCLAIMED. IN NO EVENT SHALL
CALIFORNIA ENERGY COMMISSION, WRIGHTSOFT CORPORATION, ITRON, INC. OR ANY
OTHER AUTHOR OR COPYRIGHT HOLDER OF THIS SOFTWARE (COLLECTIVELY, THE
"AUTHORS") BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. EACH LICENSEE AND SUBLICENSEE
OF THE SOFTWARE AGREES NOT TO ASSERT ANY CLAIM AGAINST ANY OF THE
AUTHORS RELATING TO THIS SOFTWARE, WHETHER DUE TO PERFORMANCE ISSUES,
TITLE OR INFRINGEMENT ISSUES, STRICT LIABILITY OR OTHERWISE.
Return to Quick Start Main Menu
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